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Computer Graphics Lab 1:
2-D Computer Sketching I

INTRODUCTION TO SOLIDWORKS

SolidWorks© is a parametric solid modeling package that is used to build solid computer
models. The designer starts with a 2-D sketch that at first is loosely defined. Dimensions and
other constraints are applied to the 2-D sketch to fully define its geometry. The sketch is turned
into a 3-D solid model using an extrusion or revolution. If the base part is not correct, the
designer can simply change the dimensions of the original sketch or definition of the base feature,
and then re-build the part with a click of the mouse. Once the base part is defined, new sketches
can be defined on planes around the base part, and they can then be extruded to form bosses and
cuts on the part. Also, special design features can be easily added to the part, such as fillets,
chamfers, and counter bores. This is called feature-based modeling and it is the latest approach
to 3-D computer modeling. In this first computer graphics lab, you will concentrate on 2-D
computer sketching methods, and will extrude or revolve simple parts. Four different, short
exercises are provided.

SOLIDWORKS TOOLBARS SETUP

Your instructor will show you how to launch SolidWorks on your computer. When you first
launch SolidWorks the screen will appear as shown in Figure 1-1. Your first task is to set up
your SolidWorks screen layout to have a common appearance that will be referenced throughout
this workbook. To accomplish this, follow these instructions. Go to the View pull-down menu
on the top of screen, select Toolbars and deactivate all the toolbars except
Dimensions/Relations, Features, Sketch, Standard, Standard Views, and View, as
shown in Figure 1-2. P ———

This will arrange the e
common toolbars

around your screen for
easy access during
your exercises. Note
that these toolbars will
not appear until you
have begun to
construct a new part.
As you get familiar
with the screen and the
commands, you may
choose to customize
your toolbars to fit
your needs.

Figure 1-1. The initial screen in SolidWorks
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Figure 1-2. Setting the Proper
Screen Toolbars during Setup

STARTING A NEW PART

To start your session with SolidWorks, you need to pull
down the File main menu and click on the New command.
This will invoke an on-screen menu, as shown in Figure 1-
3. You have three options: Part, Assembly, and Drawing.
To start a new model, click Part and then OK. Once you
have clicked the OK button, the screen changes into the
SolidWorks computer working space with all the previously
checked toolbars ready to be used. Your first step is to
study this initial screen layout as depicted in Figure 1-4.
Some of the toolbars may appear at other positions on the

screen.
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Figure 1-3. Starting a New Part in SolidWorks

THE SOLIDWORKS
SCREEN LAYOUT

The SolidWorks screen layout
when you start a part uses the
top, left, and right side of the
screen to arrange various
menus and toolbars.  The
center of the screen is the
computer sketching area for
your design work.  Study
Figure 1-4 to become
familiar with this standard
screen layout. Each of these
menus and toolbars will be
described in the subsequent
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Figure 1-4. The SolidWorks Screen Layout with Major
Menus and Toolbars Identified

paragraphs.
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MAIN MENU

File is where you can create New files and Open, Save, Print Preview, and Print existing files.
You also can set up your Page on this menu.

Edit is where you can Undo the last command, and Cut, Copy, and Paste Entities. It also has the
Rebuild command that you may find convenient when you make changes to your model.

View is where you Redraw and set Display parameters. You can set the View Orientation, and
select View commands like Zoom, Rotate, and Pan.

Insert is where the major feature creation commands are located. Here you can create the Base
part, Cut the part, and invoke many of the parametric features.

Tools has an assortment of helpful commands. It has Sketching Tools, Dimensioning Tools, and
Relations Tools. It also has analysis tools like Mass Properties.

Window is where you can set some window properties like vertical and horizontal tiling.

Help is where you can access on screen listings of the command functions and other information
that will help you navigate and learn SolidWorks.

FEATURE MANAGER TREE

SolidWorks has a special “Feature Manager Tree” capability that

J{% EREED »
T

~
keeps track of the solid modeling process. It relates each feature @ part] ]
with the appropriate sketch in a tree diagram and allows you to &-{&] Annotations
edit your feature later if needed. The “Feature Manager” will 85 Material <not specifisd>
appear after you have begun a new part or have opened an o <\> Frant Plane
existing solid model. It is located in the upper left part of the """ @
screen. Figure 1-5 shows an example of the Feature Manager. - i z'fi';;ma”e

E {-) Sketchl
THE REBUILD BUTTON Figure 1-5. Feature

Manager Tree

The “Rebuild Button” is located on the Standard
Toolbar and looks like a red/green traffic light, as —
shown in Figure 1-6. When you press it with the | ®-9-Gl-8)E-

mouse button, it will rebuild your model andupdate | 4 @FAEBFEIE I D > | O
any changes that have been made.

3
+ | Rebuwild
| Display/Delete  Cuickl Rebuilds the part, assembly, or drawing,

Malednma

Figure 1;6. The Rebuild Button

TOOLBARS

Toolbars are clickable icons along the top and side of the screen that permit quick and easy
access to some of the more common commands used in SolidWorks. You can see the toolbars,
grouped by function, in the general screen layout of Figure 1-4 on page 1-2.
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View and Standard View Toolbars are shown in Figure 1-7. The View Toolbar contains
buttons for several Zoom commands, the Rotate View command, and the Pan (Move) View
command. It also has icons to represent your model as a wireframe, with light gray hidden lines,
with hidden lines removed, as a shaded image, and as a shaded image with a shadow. The
Standard View Toolbar allows you to select Front, Back, Left, Right, Top, Bottom, Isometric,
and Normal Views
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Figure 1-7. The View and Standard View Toolbars on the Top of

The

SKETCH TOOLBAR:
sketch
shown in Figure 1-8,
can be divided
sketch entities, relations,
and dimension
To start, you click on
the Sketch icon.
you establish 2-D sketch
entities,
Dimension
Relation buttons to fix
the

parameters

toolbar
into
tools.
As

you can use

and Add

geometric
of  your

design. To aid you in your sketching, numerous 2-D entity icons are available, such as Line,
Arc, Circle, and Rectangle. To edit your sketch, several common commands like Trim,

Mirror, Fillet, and Offset are available.
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Figure 1-8. Sketch Toolbar Options

SKETCHING PLANES
Before you start a 2-D sketch with SolidWorks,

you must define (highlight) a sketch plane.

The

three default orthogonal sketch planes are the three
standard orthographic view planes: Front, Top,
and Right, as shown in Figure 1-9. Later, you
can also pick any plane or flat surface on a base

part that has been created. The

Figure 1-9. The Default
Sketch Planes
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LINE COLORS

SolidWorks has several ways to feedback information to the user. One of these ways is to use
different line colors. When sketching 2-D profiles, the following color codes prevail.

Green lines mean that the entities are Selected.

Blue lines mean that the dimensions of the geometry are Under Defined.

Black lines mean that the dimensions of the geometry are Fully Defined.

Yellow lines mean that the dimensions of the geometry are Over Defined (undesirable).
Gray lines mean that these entities are not in the active sketch.

STANDARD TEMPLATES

[ g

Load Fr.

Before you start any exercises in
SolidWorks, it is a good idea to
establish some standard drawing
templates and title blocks to reflect the
two styles of engineering
measurements. One set will be for the
American National Standards Institute
(ANSI) for Inches and the other for

Metric.

To start, go to File, select New, then
Part and OK this selection. Go to the Figure 1-10. Document Properties Menu
Tools pull-down menu. Select

Options. Under the Document
Properties tab, make sure that the
Dimensioning Standard is set for
ANSI (see Figure 1-10). Next select
Units in the left hand column of the
menu. In the window that appears,
activate IPS  (Inch, Pound,
Second). You should also increase
the Decimal Places to four (4) as
indicated in Figure 1-11. Close the _

“Document Properties” menu with the ' " —=5 1
OK button. Now go to File and select - e
Save As. First select the FOLDER
you wish to save this template in, then
title your part as ANSI-INCHES, Figure 1-11. Units Menu
select Save as Type and select Part
Templates (*.prtdot). Then save it in your folder.

Repeat the above process, only this time, the Units you select will be MMGS (Millimeter,
Gram, Second). Two decimals should be sufficient for metric measurements. Save this
template also in your FOLDER, but change your title to ANSI-METRIC and select the Save as
Type and select Part Templates (*.prtdot).

x|

Document Properties - Units

@1ps (jnch, pound, secons
Q Custom

$- Annotations Display

Type Junie Decimals  [Fractions More
Basic Units

Length inches [
Dual Dimension Length [inches 1234
Angle dearees 1z

Mass,/Section Properties
Length inches |‘1234 K|

ﬁess pounds Hgi 2

Per Unit olume: inches™3
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STANDARD TITLE BLOCK DRAWING SHEETS

The next process is to set up a Title Block to reflect the two measurement styles. You may have
to draw a title block (see Figure 1-12) if one has not been provided. An example of a title block,
with suggested dimensions and style, is available in Appendix A. If a Title Block has been
provided, go to File and Open that drawing file. Go to the Tools pull-down menu and select
Options. Under the Document Properties tab make sure that the Dimensioning
Standard is set for ANSI. Next select Units in the left hand column. In the window that
appears, activate IPS (Inch, Pound, Second). Three (3) decimal places will be all you should
use here unless you are doing very high tolerance drawings.

Go to Insert — Annotations - Note to add your personal information, such as NAME, DESK
NUMBER, and SECTION NUMBER. In the Feature Manager Tree, right click on Sheet 1
and select Edit Sheet. Now that this is done, go to File and Save As. First select the
FOLDER you wish to save this template in, then title your part as TITLEBLOCK-INCHES and
select the Save as Type and select Drawing Template (*.drwdot).

Repeat the above process, only this time, the Units you select will be MMGS (Millimeter,
Gram, Second). Two (2) decimals should be sufficient for metric measurements. Add your
personal information such as NAME, DESK NUMBER, and SECTION NUMBER. In the
Feature Manager Tree, right click on Sheet 1 and select Edit Sheet. Save this template in
the same way, but change your title to TITLEBLOCK-METRIC and select the Save as Type
and select Drawing Template (*.drwdot).

INSERTING A PART (RENDERED PICTORIAL) ONTO A TITLE BLOCK SHEET

For each of the assignments you will be asked to submit a printed copy of the part that you built
in SolidWorks. The following will be the procedure to accomplish this requirement.

A. Build the solid model according to instructions and save that part in your folder with the
file extension of .sldprt.

B. Open the appropriate Title Block drawing sheet (sece Figure 1-12 for example). The
Title Block drawing sheet that you open should have the same units as the solid part
(metric or inches).

C. Pull down Windows and then select Tile Vertically. This allows you to see all the
windows that you have open at the same time.

D. Select the Part Name in the Feature Manager Tree and while holding down the left
mouse button, drag it onto the Title Block drawing sheet. At this time you have several
options available to choose from. For most of your labs you will be choosing a pictorial
view or current view. In unit nine and ten you will be choosing the three views layout of
the object that you insert onto the Title Block. If you do not see the three views, right
click on Sheet 1 in the Feature Manager Tree and sclect Edit Sheet.



E. Pick the window around the pictorial view. You get a menu window that lets you adjust
the scale of the image to better fill the sheet.

F. In the drawing area of the Title Block Sheet Insert the title of the object. Provide the
exercise number in the upper right hand box of the Title Block. Your Title should be
placed in an open area of the Title Block and a larger font size, i.e. 0.20 or 0.25. Your
name, desk, Sec and exercise number should be font size 0.125 or 12pt.

TITLE OF THE EXERCISE

20 OR 25 PT OR .25"

EXERCISE NUMBER
12PT OR 125"

SECTION OR UNIQUE NUMBER

12PT OR 125"
LAST NAME FIRST, FIRST NAME
12PT OR 125" DESK NUMBER
\ 12PT OR 125"
NAME: © pEsf™ __ sec ]

ENGINEERING PESIGN GRAPHICS

Figure 1-12. An Example of a Student
Title Block Sheet
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Exercise 1.1: METAL GASKET

In this first exercise, you will build a metal gasket part. This part is primarily a 2-D object with a
thin depth that will be extruded. The gasket features can be drawn with many of the 2-D
sketching entities and editing features using the sketch toolbars. Go to your folder and Open the
file ANSI-INCHES.prtdot. In order to avoid corrupting the ANSI-INCHES.prtdot template
go to File - Save as: under File Name, type METAL GASKET, and under Save as type,
Select .sldprt and select SAVE.

First set up the sketching grid and
units. Pull down the Tools menu
and select Options. Under the | [Svstem optians | Document Properties

Document Properties - Grid/Snap

Document Properties tab, click | ||[F=m —— au
N i+ Dimensions 7] Display ari
the Grid/Snap tab and set the | ||| o e

i Balloons

L Brrows

i Yirtual Sharps Major grid spacing:
Annotations Display

i Annotations Fonk Minor-lines per major:

)
Snap poinks per rminor:

Aukomatic scaling

“Major grid spacing” to 0.25 and
“Minor lines per major” to 1. Also
click on (V) all the “Grid” boxes

and set “Snap points per minor” to | | ||&e
1, as shown in Figure 1-13. Click | | |[|foee == e
:
on the Go To System Snaps and | | [|fmere
make sure that the Grid and Snap e,
H H H | hain Dimension
only When grld IS dlsplayed | %---EeometiricTolerance

boxes are checked. Also make sure [ | || -cronfer coneos
the Units are in Inches to 2 | |

decimal places. Then click OK to
close the menu.

Figure 1-13. Setting Grids and Units for the Sketch

You will design the gasket in the front view, so click on the Front plane in the Feature Manager
tree. The front plane should highlight in cyan. Next click on the Sketch icon (drawing pencil)
on the upper left side or the screen. The sketching grid will now appear on the screen with grids
spaced every 0.25 inches. Also make sure you are viewing this from the Front View orientation
(see Figure 1-7).

Now study the outline of the gasket shown in Figure 1-14. You will sketch this outline on the
quarter-inch grids using the line tool. Click the Line icon on the sketch menu toolbar. Now
draw five lines according to the specifications in Figure 1-14 and detailed below. All (X,Y)
coordinates are relative to the sketch “origin” seen in the middle of the screen.

The top line starts at (-2.75, 1.25) and ends at (2.75, 1.25).

The right side line starts at (2.75, 1.25) and ends at (2.75, -1.25).

The bottom right diagonal line starts at (2.75, -1.25) and ends at (0.00, -2.75).
The bottom left diagonal line starts at (0.00, -2.75) and ends at (-2.75, -1.25).
The left side line starts at (-2.75, -1.25) and ends at (-2.75, 1.25).

The 2-D outline of the gasket should now be finished and completely enclosed.
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Figure 1-14. The Beginning Outline for the Metal Gasket

The five corners of the gasket are sharp and need to be rounded. This can easily be accomplished
using the fillet editing command. Click the Fillet icon (round corner symbol) on the sketching
toolbar. Notice that a “Sketch Fillet” menu now appears where the Feature Manger tree usually
is displayed (Figure 1-15). Key in a fillet radius of 0.50 inches. Now, one by one, click on the
two edges of the corners (or merely click on the point of intersection) to create a fillet there.
Once the five fillets are added, click on the green (\/) button on the “Sketch Fillet” menu. The
five fillets are now completed as shown later in Figure 1-16.

Sketch Fllet d
« B O
Fillet Parameters b

A\ | 0,500

Keep conskrained
COFNErs

LLLLLLLLLL

(P O RP IS GO P EC(H G L DO

==

P RCPPEPReEPESPo SRo

Figure 1-15. Sketch Fillet
Menu
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Figure 1-16. Filleting the Five Sharp Corners
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Using the Rectangle sketching tool, draw a rectangular slot 3.00 inches wide by 0.50 inches
high, and completely centered on the origin, as shown in Figure 1-18. Next select the Circle
sketching tool, and create the five circles concentric to the corners of the outline. All circles have
the same diameter of 0.50 inches. Note: When drawing the five circle make sure that you pull
your mouse horizontally so the cursor will snap to the grid, giving you a diameter of 0.50 inches
Note: While you are sketching the lines, rectangle, or circles, the end of the cursor pencil shows
a small icon that indicates the current type of sketch entity that you are using. This is called a
“smart cursor.” Now add four Fillets to the inner corners of the rectangular slot. Use a radius of

0.125.

Now you will draw a polygon on the gasket. Pull down Tools, select Sketch Entities, and
then select Polygon. The “Polygon” menu appears on the screen where the previous fillet menu
appeared. First draw the polygon on the gasket in
its approximate position. Now study the actual
parameters ne_eded for the polygon and then set them [E& " ﬁ‘ I % ][$. ]
as shown in Figure 1-17.

Number of sides = 6 Polygon ki

Inscribed circle dot o

X-origin = 0.00

Y-origin =-1.00 ' Options g |

Inscribed circle diameter = 1.00 A —

Rotation angle = 0°
Once the parameters are set, click on the green (\/)
button on the “Polygon” menu to close the menu and — -
complete the polygon, as shown in Figure 1-18. @ & =
The next feature to sketch is a “fan” shaped quarter- {+) Inscribed circle
circle. First, sketch a horizontal Line from (150, - C}Circumscrihed circle
0.50) to (0.75, -0.50). Then draw a vertical Line .
from (0.75, -0.50) to (0.75, -1.25). To add the | || oy |0.00 =
quarter circle arc, select the Centerpoint Arc @ 00 =
sketching icon. Click the center of the arc to be at the v : e
intersection of the two lines just drawn. Hold the left @ 1.0 -
mouse button (LMB) down and drag the cursor down =%
to the end of the vertical line. Click the LMB at that B 0.00° -
point to define one end of the arc. Then hold it down =
and drag it to the end of the horizontal line. Once | Mew Polygan
again, click the LMB at that point to complete the arc.
You should have a drawn arc feature as shown in ]
Figure 1-18. Figure 1-17. Polygon Menu
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Figure 1-18. Sketching the Polygon and Right Side Fan-Shaped Arc

You now need to finish the gasket by creating a symmetric arc feature on the left side of the
polygon. SolidWorks offers many tools for sketching and editing. One of these tools is the
“Mirror” sketch feature about a centerline. Select the Centerline sketch icon, which is in the
pull down menu of the line command, and draw a centerline vertically from top to bottom, and
through the origin, as shown in Figure 1-18 above. Now click the Mirror (bell-shaped) icon. A
mirror menu will appear over the Feature Manager tree. Select (LMB) the three lines of fan
shaped arc feature. Now activate the Mirror About box and select the centerline. The fan-
shaped arc feature will now mirror to the left side. The gasket outline is now complete as shown
in Figure 1-19.




EXTRUDING THE GASKET THICKNESS

The gasket can now be extruded to its proper thickness.

Select the Features icon and select Extrude or pull down 913 Revalied Bom/Base

the Insert main menu, select Boss/Base, and then ::;Ug:ge

Extrude, as shown in Figure 1-20. The “Extrude” menu

then appears on the screen in the Feature Manager area | | Featlves [“Sketch [ Evaluate [ Dimipert

(Figure 1-21). Set the parameters for the extrusion:

Direction One Blind
Distancel = 0.125 inches

@' Extruded Boss/Base
Extrudes a sketch or selected sketch
- contours in ane or bwa directions to
c»%‘a create a solid Feature,

Notice that the extrusion appears as a preview in the
computer sketching area in an Isometric view. Click on (\)
the green button on the “Extrude” menu to finish.

Figure 1-20. Extruding the
Gasket Thickness

Now you can view your model. On the “View Orientation” window click Trimetric. You
should see the thin solid model appear as a trimetric view (see Figure 1-22). Also try
Isometric, Dimetric, and Front view orientations. You can experiment with some of the
viewing operations in SolidWorks. Click the Rotate View icon (it appears as circular arrows on
the top toolbars) or press down on the center wheel of the mouse. Now rotate your model into

different configurations. Also try several Zoom commands and the Pan command.

If you would like to change the color of your model, click on the
model name in the Feature manager tree and then select the
colored ball in the menu bar. You can then assign any color you

EIEAEYED

< to th del il Extrude ?
ish to the model.
v v R 6
You should save your model. Now save your model. Pull down — -
the File menu and select Save As. On the “Save As” menu, [Seetch Plane =l
select your appropriate file folder in your account, type in the
part name METAL GASKET, and the file type as sldprt, then Direction 1 2
click Save. |TK| |B|in|:| v|
Before you finish this exercise, you should print a hard copy for Py,

submission to your instructor. Check with your instructor first
for any special printing instructions. You may need to use a
special sheet like the Title Sheet shown in Figure 1-12. You
can insert the rendered Metal Gasket image into your Title
Block drawing sheet that was created in the introduction to this
chapter, as shown in Figure 1-22. To put this object on a Title
Sheet, follow the instructions on Page 1-7.

Conversely, you can place your name and class data on the
printed drawing. Pull down the Insert menu, select
Annotations, then Note. A note box appears at the end of the
cursor and a “Note” menu appears in the Feature Manager area.
Type in your name and class data in the note box.

1-12
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Figure 1-21. Extrude
Menu




If you check (\/) off the “Use documents Font” in the menu, you can change the font, for example
to:

Font = Arial

Font Style = Regular

Points = 12

Now SAVE your drawing sheet to your directory as METAL GASKET.slddrw. Take note that
the title of the part and the drawing are the same but the extension has changed. The solid model
and the drawing are linked, meaning that any changes made to the solid model will automatically
be updated on the drawing.

Before you print your copy, make sure you have set the File, Page Setup to Landscape
mode. Now pull down the File and Print Preview commands from the top main menu, then the
Print button to send it to the default printer.

O
©

-

(O
»,

©

——

METAL GASKET @

name: STUDENT peskcor  sec: 01 ™ | 14

ENGINEERING DESIGN GRAPHICS

Figure 1-22. Metal Gasket Model Inserted into the Title Block Drawing Sheet



Exercise 1.2: COVER PLATE

There are many different approaches to creating a 2-D computer sketch using SolidWorks. The
approach will depend on the design intent and also on the designer’s own preferences and
choices. In the previous Exercise 1.1, geometry was constructed on a frontal plane using X-Y
coordinate geometry and a grid system. In this Exercise 1.2, you will construct the 2-D geometry
on a horizontal (top) plane since this is the normal orientation of the cover plate. Also, instead of
using a grid coordinate system for laying out the design, you will use simple dimensions related

to the geometry and to the computer space origin.

Go to your folder and Open the file ANSI-INCHES.prtdot. In order to avoid corrupting the
ANSI-INCHES.prtdot template go to File - Save as: under File Name, type COVER

PLATE, and under Save as type, Select
.sldprt and select SAVE. Click the Top plane
in the “Feature Manager.” Also click Top view
in the Standard View toolbar to see the top plane
in green on the screen. Now click the Sketch
icon on the upper left toolbar, then click the
Circle icon. Draw a large circle that is centered
at the origin. For now, the diameter is
unimportant because you will dimension it. Click
the Dimension icon (slanted dimension line) on
the right toolbar. Pick a point on the
circumference of the circle and drag the
dimension out to the upper right side of the circle.
The dimension is not likely to be correct, as soon
as you place the dimension a small Modify box
appears (see Figure 1-23). Key in 10.00 inches
and click the green (V) check box. The diameter
of the circle changes to the new value. If the
circle gets too big, use Zoom to see it better.

Now you will extrude the circle into the solid
base part of the cover plate. Select the Features
icon and select Extrude or pull down Insert,
select Boss/Base, and then Extrude. Set the
parameters for the extrude to be:

Direction One = Blind

Distancel = 0.50 inches
Click the green (V) button on the “Extrude” menu
to finish. View the cover plate as an Isometric
(Figure 1-24).

Figure 1-23. Setting the Circle

Diameter

IlD.DDin VI:
v[X| 8|2

Figure 1-24. Base Part of the Cover

Plate




You will now draw the geometry for the indentation part of the cover plate. Click on the top
surface of the Cover Plate model and it should turn ¢cyan. This will be the next sketch
surface. Also select Top on “View Orientation” for better viewing of the sketch plane. Click the
Sketch icon to start the next sketch. Select Circle and draw a circle centered at the origin.
Now draw a second bigger circle centered at the origin, but not as big as the 10.00 inch diameter
of the base plate. Now, using the Dimension icon, set the diameter of the smaller new circle to
4.00 inches and the diameter of the bigger new circle to 8.00 inches.

Using the Line sketching tool, draw two parallel lines across the plate. One line should be
slightly above the origin, and the other should be below. Both should span across the two circles
as shown in Figure 1-25. Next Dimension them so that one line is 0.50 inches above the
origin, and the other is 0.50 inches below the origin. This places the parallel lines 1.00 inch
apart, as indicated in Figure 1-25.

#8.00 P4.00

—1.00

— .50

Figure 1-25. The Beginning Geometry for the Indentation

Now you will trim these lines. Now select the Trim icon on the sketch editing toolbar. In the
area where the Feature Manager tree is you will see a Trim - Options box. Select the last
option (Trim to Closest). A scissors icon now appears on the end of the cursor indicating that
you are in the trim mode. Trim the line portions (four places) that extend beyond the big circle
by just clicking on them with the LMB. Next trim the two line pieces inside the small circle.
Finally trim the portions of the circles that cross between the two parallel lines (four places).
You should now have a pattern like in Figure 1-26. Now repeat the above process (Line,
Dimension, Trim) to create identical patterns in the vertical direction. This final pattern for the
indentation is shown in Figure 1-27.



Figure 1-26. The Initial Pattern after Trimming the Lines and the Circles

Figure 1-27. The Finished Pattern for the Indentation



Now you will cut the indentation pattern into the cover
plate. It is advisable to go to an Isometric view
when executing an extrusion of any kind. Select the

Features icon and select Extruded Cut or pull Q
down Insert, select Cut, and then Extrude. The

“Cut Extrude” menu appears in the Feature Manager
area. Key in these parameters:

Direction One = Blind
Distancel = 0.25 inches

Click the green (V) button to finish. View the cover

lat tated Isometric (Figure 1-28).
plaleas a rotate ic (Figu ) Figure 1-28. The Indentation Pattern

Now create the lift hole in the middle of the plate. Cut into the Plate

Click the cursor on the top center surface of the cover
plate (it should turn cyan). Also, select a TOp view orientation. You might also need to Zoom
in to see the center portion better. Click the Sketch icon to get into the sketching mode. Since
the lift hole is symmetric about the origin, you can use a mirror function. So start by drawing a
vertical Centerline (CL) through the origin. Next go to TOOLS — SKETCH TOOLS -
DYNAMIC MIRROR. There should be short horizontal lines on either end of the centerline you
drew. Every operation you perform on the right side is duplicated on the left side. Now, draw a

small Circle to the right side of the

centerline. Then draw two parallel Lines ‘ L 7500 3
that start at the centerline and go through 7

part of the circle, as indicated in Figure 1- T

29. Now apply the following inch | P.7500

Dimensions to the sketch geometry. |
Circle Diameter = 0.75 |
Lateral Dist. from CL = 0.75 Ve
Linel from origin = 0.20 (above) G : *
Line2 from origin = 0.20 (below) ~—
Circle center = 0.20 (above Line2)

2000

o]
[

|
: o |
Now Trim the two line pieces that :
overhang the circle, and then trim the part |
of the circle between the two parallel lines. i
If you get a warning from SolidWorks

about eliminating associated dimensions | Figure 1-29. Geometry and Dimensions for the
while you are trimming, just ignore it and Lift Hole

answer Yes to proceed with the trim.

Cut the lift-hole pattern through the cover plate. It is advisable to go to an Isometric view
when executing an extrusion of any kind. Select the Features icon and select Extruded Cut or
pull down Insert, select Cut, and then Extrude. The “Cut Extrude” menu appears in the
Feature Manager area. For Directionl, just select Through All. Click the green (V) button to
finish this extrude-cut operation and view the lift hole in Figure 1-30.



To finish the cover plate, you need to add
four circles around the perimeter to make
the guide holes. Click the cursor on the top
surface again and Sketch four Circles
around the perimeter of the cover plate.
The circles should be at 90 degrees to each
other. The centers should be on the
perimeter and aligned with the origin. The
diameter of all four circles should be 0.75,
as shown in Figure 1-30.

Now pull down Insert, select Cut, and
then Extrude. The “Cut Extrude” menu
appears in the Feature Manager area. For
Directionl, just select Through All, and Figure 1-30. Sketching the Circles for the
click the green (V) button to finish the part. Guide Holes

Now view your model in an Isometric
view, as shown in Figure 1-31.

If you would like to change the color of your model, click on the model name in the Feature
manager tree and then select the colored ball in the menu bar. You can then assign any color you
wish to the model.

You should now save your model. Pull down File, select your file folder, sclect Save As, type
in the part name COVER PLATE.sldprt, then click Save. Insert the rendered Cover Plate
image into your Title

Block drawing sheet that
was created in the
introduction to Chapter 1
(See Figure 1-31.
Follow the instruction
given on Page 1-7. Now
SAVE your drawing sheet
to your directory as
COVER

PLATE.slddrw. Take
note that the title of the
part and the drawing are
the same but the extension
has changed. The solid
model and the drawing are
linked, meaning that any

COVER PLATE
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changes made to the solid ENGINEERING DESIGN GRAPHICS
model will automatically
be updated on the drawing. Figure 1-31. The Finished Cover Plate Part



Exercise 1.3: WALL BRACKET

The sketch geometry used in Exercises 1.1 and 1.2, like line, circle, rectangle, and arc, are
sufficient for designing many different kinds of parts. Sometimes more advanced 2D geometry,
like an irregular curve, may be needed to complete a design. In the case of the Wall Bracket for
this Exercise 1.3, you will learn how to use a spline.

Go to your folder and Open the file ANSI-INCHES.prtdot. In order to avoid corrupting the
ANSI-INCHES.prtdot template go to File - Save as: under File Name, type WALL
BRACKET, and under Save as type, Select .sldprt and select SAVE. Click the Front plane
in the “Feature Manager.” Also click Front view in the Standard View toolbar to see the front
plane in cyan on the screen. Now click the Sketch icon on the right toolbar. First sketch the
straight line segments of the Wall Bracket outline using the Line tool. Refer to Figure 1-32 for
the proper Dimension for each line segment. Units are in inches and the upper left corner is at
the origin.

8.00 .25
ORIGIN :

25\1

o
o

Figure 1-32. Sketching and Dimensioning the Wall Bracket Lines

Now you will draw a spline from the bottom of the 4.25 inch line to the bottom of the 1.00 inch
line. Click the Spline sketch icon (it looks like a sine wave). Click the LMB at the first bottom
point. Then with the mouse pressed down, drag the spline over to the first intermediate point
about one third of the way up and about one third of the way to the right. Release the LMB there,
then press it down again and drag the spline to the second intermediate point about two thirds of
the way up and over. Again release the LMB there, then press it down again and drag the spline
to the final point, where you end the spline by double clicking the LMB. Refer to Figure 1-33
for these four points’ positions.

The two intermediate points are used to control the shape of the spline. With the Select cursor,
pick the spline (it should highlight cyan with its four points identified). Now pick intermediate




point 1 and drag it out and down a little to create a slight bulge. Next pick intermediate point 2
and pull it up a little to create a slight inflection (see Figure 1-34). Note: There are no exact X-
Y coordinates for you to drag these intermediate points to. Just try it a few times until you
achieve a shape that pleases you (for example the shape in Figure 1-34 is acceptable).

.00 25
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\ — 1.00
Spline o
4.25 \A
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o Intermed. Pt. 2

| \

7 Intermed. Pt. 1
Start Pt.
Figure 1-33. Sketching the Spline through its Four Points
- 8.00 o 25
! L I 25
! i T I
L 1.00
4.25
Drag Intermed. Pt. 2

Figure 1-34. Dragging the Intermediate Points to Shape the Spline
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Now you will complete the left end of the Wall
Bracket by adding the wall hooks. On the left
edge, add the two wall hooks using the Line 50
tool and the Dimension values given in

Figure 1-35. You will have to Trim two l
places on the left edge to make the wall hooks 50 &
contiguous with the rest of the profile. Note: T
The bottom wall hook has the same dimensions 75
as the top one.

— .50

You will finish the Wall Bracket by adding a 425
fillet to the sharp bottom corner on the right
end. Since it was earlier associated with the
1.00 inch dimension, SolidWorks will give you U

a warning if you try to fillet it. So it is best to
just first Delete that dimension. Now click the
Fillet sketch icon. Key in a radius of 0.25
inches (refer back to Figure 1-16). Next pick
the vertical 1.00 inch right edge of the bracket
and pick the spline close to its end point, and
then click the green (V) check to execute the
fillet command. The 2D profile is now
complete and ready to be extruded. Pull down
Insert, Boss/Base, and Extrude. Key in a Blind distance of 0.125 and click the green (V)
check to complete the Wall Bracket, as shown in Figure 1-36 in a Trimetric view.

Figure 1-35. The Dimensions Used to
Create the Wall Hooks on the Left Side

If you would like to change the
color of your model, click on the
model name in the Feature WALL BRACKET
manager tree and then select the
colored ball in the menu bar. You
can then assign any color you wish
to the model.

Now Save the part as WALL E
BRACKET.sldprt.  Insert the
Wall Bracket onto a Title Block TTTe——
drawing sheet. Save as WALL
BRACKET.slddrw and Print a
hard copy for your instructor. See

_ 1 1 | rsme: STUDENT DESK SEC | EE
Page 1 7 for Instructions. | ENGINEERING DESIGN GRAPHICS

Figure 1-36. The Completed Wall Bracket
in a Trimetric View
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Exercise 1.4: MACHINE HANDLE

In the previous exercises, the parts were designed using English units (inches). Metric, or System
International (SI), units are also common in engineering practice. In this exercise 1.4, the
Machine Handle will be designed using millimeters as the basic units (see Figure 1-37). In
addition, because of the round symmetry of the machine handle, you will create a Base
Revolve using the 2-D sketch rather than a base extrude.

Go to your folder and Open the file ANSI-METRIC.prtdot. In order to avoid corrupting the
ANSI- METRIC.prtdot template go to File - Save as: under File Name, type MACHINE
HANDLE, and under Save as type, Sclect .sldprt and select SAVE.

Next, Go to TOOLS - OPTIONS — DOCUMENT PROPERTIES and Select “Grid/Snap.”
Make the following settings on this menu:

“Major grid spacing” =5 mm

“Minor lines per major” =0

“Check the Display Grid box (V).

Also go to System Snaps and make sure “Grid” and the “Snap” functions are checked (\/) on,
then click the OK button.

Pick a Front plane and click the Sketch icon to start your sketch. The screen area should show
a metric grid with spacing every 5 millimeters. You may need to Zoom in. Using the
Centerline, Line, and Centerpoint Arc tools, sketch the enclosed 2-D profile shown in
Figure 1-37.

o

igi Centefling

Figure 1-37. The 2-D Sketch for the Machine Handle
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Now you will revolve this simple sketch into a solid
model. Go to the Features option and Select the
Revolve Base/Boss icon. The “Base Revolve”
menu appears in the Feature Manager area as
shown in Figure 1-38. The main choice you have
here is the degrees of revolution about the
centerline. Set it to a full revolution of 360° and
then click the green (V) check to close it. Your part
should now appear as shown in Figure 1-39 with
an Isometric view.

There are many different designs for a Machine
Handle, and the one here is quite typical. After
studying it, however, you notice that the sharp outer
edge on the right side poses a concern. SolidWorks
allows you to easily fix these design changes after
the solid model has been built. One way is to
simply go back and edit the original sketch.

Notice in the Feature Manager that SolidWorks
keeps a running tabulation of the features you used
to build the part. One of them should read “Base
Revolve,” which is the operation you just
completed. Left of this “Base Revolve” is a plus
(+) sign. Click on this (+) sign and down comes the
name of “Sketchl.” Right mouse click on this
Sketchl label and a short pull-down menu appears
as shown in Figure 1-40. Left mouse click on the
Edit Sketch option and the sketch appears again,
with grids, on the screen. Select the Front view
orientation to better see the sketch.

There are different ways to eliminate the sharp
edge. One way is to use a chamfer; however you
probably cannot find a chamfer icon on the sketch
editing toolbars. The chamfer icon is nested with
the fillet icon. A down arrow next to the fillet icon
is another pull down menu and under that menu is
the Chamfer icon. The “Sketch Chamfer” menu
now appears. Set the “Chamfer parameters” as
shown in Figure 1-41, including the chamfer
distance of 3 mm. Now click on the two lines that
form the sharp edge corner, and then click the green
(‘/) check to complete this chamfer operation.
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Figure 1-38. Revolve Menu

Figure 1-39. The Part after the Sketch

is Revolved
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Figure 1

-40. Editing the Sketch




The new feature is created, but the new model is not displayed yet. You need to rebuild the
model first. Pull down Edit, and select the Rebuild option (it may be in the customize menu
section of the pull-down menu). Note: There is also a small icon for the rebuild command. It
appears on the top toolbar and looks like a green and red traffic light. The model is rebuilt now
with a chamfer, as shown in the final picture (Figure 1-42) in an Isometric view with the
Shadows in Shaded icon clicked on. Now you see how easy it is to make design changes to
a solid model that is already built. You just simply edit the sketch that created the model in the
first place.

Sketch Chamfer

R &

- Chamfer Parameters |

() angle-distance
{+) Distance-distance

Equal distance

<, [ 3.0000mm . A
Figure 1-42. The Machine Handle in
Figure 1-41. The Sketch Chamfer Menu an Isometric View with a Shadow

If you would like to change the color of your model, click on the model name in the Feature
manager tree and then select the colored ball in the menu bar. You can then assign any color you
wish to the model.

You should now save your model. =0T s T
Pull down File, select Save As,
type in the part name MACHINE
HANDLE.sldprt, and then click
Save. Insert the rendered
Machine Handle image into your
Title Block drawing sheet, as
shown in Figure 1-43. Add the
title of the part in the open area of
the drawing with a 20pt or 6mm
letter height. Also add the
Exercise number (4.1) in the
upper right hand box of the Title
Sheet. Now SAVE your drawing
sheet to your directory as
MACHINE HANDLE.slddrw.

MACHINE HANDLE

[ nawe STUDENT oesic 01 sec 01 [ ™ |
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Figure 1-43. A Print Preview of the Machine Handle
on the Title Block Drawing Sheet
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Supplementary Exercise 1-5: SLOTTED BASE

Make a full size sketch of the figure below in the Top Plane and extrude it for 0.50 inches.
Insert it on a Title Block and title it “SLOTTED BASE.”

)
e

ASSUME THE GRID DIVISIONS TO BE 0.25 INCHES.

Supplementary Exercise 1-6: TRANSITION LINK

Make a full size sketch of the figure below in the Front Plane. Extrude it 0.375”. Insert it
onto a Title Block and title it TRANSITION LINK.

/
|
/
\

ASSUME THE GRID DIVISIONS TO BE 0.25 INCHES.
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Supplementary Exercise 1-7: TEE BRACKET

Make a full size sketch of the figure below in the Top Plane and extrude it to the height
indicated. Insert it on a Title Block and title it “TEE BRACKET.”

TEE
BRACKET

) =

\

ASSUME THE GRID DIVISIONS TO BE 5 MM

PICTORIAL OF THE TEE
BRACKET

Supplementary Exercise 1-8: CABLE SPOOL

Make a full size sketch of the PROFILE below in the Front Plane and do an INSERT -
BASE - REVOLVE. Insert it on a Title Block and title it “CABLE SPOOL.”

AN CABLE
@D SPOOL
PROFILE
| 1 \ ]

| |
1l |
N
| N |

<>
S

ASSUME THE GRID DIVISIONS TO BE 1.00 INCH.
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